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PS Trader Overview 

PS Trader is an add-on application to X_TRADER® that allows a trader to submit 

“entry-style” OCO orders with trailing stops through a custom user interface.  The 

application enables the trader to submit Market, Limit, Stop Limit, Stop Market, and 

OCO orders with the option to have the stops trail.  In addition, Virtual Stops, which 

are held on the client machine until the Stop Price is triggered, can be placed. 

Installation 

1. Verify that both X_TRADER and the X_TRADER API are installed.   

 

2. Double-click on the installation file (i.e. PS Trader Install.exe).  This opens the 

PS Trader installation wizard. 

 

3. Click the Next button through all of the screens of the installation wizard, 

changing the default User Information and Destination Folder if desired.  

 

4. The application will be installed.  The last screen will display a message that 

PS Trader was successfully installed.  

 

5. Click the Finish button.  A PS Trader shortcut icon will be added to the 

Desktop.  The computer does not need to be rebooted. 

Product Features 

PS Trader Basics 

6. PS Trader can be launched by double-clicking the PS Trader desktop icon after 

X_TRADER is started.  Users with X_TRADER 6.13 or higher can launch PS 

Trader from the Plug-ins button off of the X_TRADER Control Panel.  

7. Upon launching, PS Trader will automatically load up the last saved 

configuration.  If there is no previously saved configuration, a label appears in 

the center of the application that states “Drag & Drop Contracts”.  This 

application will not take any action until contracts are dropped into the 

application from X_TRADER’s Market Grid window.  

8. A contract is the combination of a Gateway, a Product, and the Expiration of 

the contract.  Ex. CME-A ES Jun04.  PS Trader supports Futures contracts, 

exchange traded Spreads, and Options. 
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9. The user can run numerous instances of PS Trader on their computer, but a 

single application will allow access to unlimited contracts.   

10. Closing the PS Trader application will not delete any resting orders that were 

entered through PS Trader, but will decouple any OCO orders leaving a 

disconnected stop and limit order.  The user can cancel these orders prior to 

closing the application.  In addition, any Virtual orders will be saved as locally 

held orders if PS Trader is closed. 

 

PS Trader – Main Window 

 

Figure 1.  PS Trader Main Window 

11. The PS Trader window contains three columns: 

 Name:  Name of the contract  

 Setup:  Launches the Setup window for the contract 

 Depth:  Launches the Depth window for the contract 

 

12. Multiple futures contracts can be dropped from X_TRADER’s Market Grid 

window to PS Trader.  Newly dropped contracts will be added as a row item to 

the end of the list.  

13. PS Trader’s main window will automatically resize to display up to 10 

different contracts.  If more than 10 contracts are added to the list a scroll bar 

will appear and the list will still contain all contracts that the user will be 

allowed to access via PS Trader. 

14. Multiple configuration files can be saved by choosing the File->Save As menu 

item.  The current contract layout and settings are saved with the workspace.  

Choosing File->Open will allow the user to open a previously saved 

configuration file.  For simplicity, the last saved configuration will be launched 

on open. 
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15. The PS Trader main window is the main control panel that is used for 

managing and launching the different depth windows.  Closing this main 

window closes the whole application and all windows associated with it. 

16. By default, the name of each depth window is the name of the contract in the 

TT Display format.  However, the user can edit the name from within the 

Setup page of each contract. 

17. The Fill Count will be displayed at the bottom of the screen.  The Fill Count 

represents the number of fills for all exchanges that X_TRADER is currently 

logged into.  This value will continue to update as more fills come in.  

PS Trader – Menu Options 

18. Within the File menu there are five menu items:  

 Open: Opens an existing PS Trader workspace 

 Save: Saves the workspace.  The default name is PS Trader.tws 

 Save As: Saves the workspace with the current/new name 

 Clear: Clears all of the contracts out of the current workspace 

 Exit: Exits the PS Trader application 

 

19. Within the Preferences menu there are nine menu items:  

 Default Settings: Opens the Default Settings Setup window to 

specify default values for new contracts added to 

the workspace 

 Global Re-centering: Enable/Disable re-centering of all Depth windows 

when any window is re-centered 

 Detached Quantity 

Pad 

Set the position where the Quantity Pad will 

display.  By default it is accessible by clicking on 

the Quantity field in the top left corner.  If checked 

it displays along the left side of the PS Trader – 

Depth window. 

 Quantity Pad Tracks 

Market 

This Preference is enabled only if Detached 

Quantity Pad is selected.  If checked the Quantity 

Pad position along the Depth window will move 

vertically up/down with the market trends.  

 Include Implieds: Include/Exclude the exchange supplied implied 

values with the market depth 

 Show LTQ: Show/Hide the Last Traded Quantity Pane 

 Confirmation 

Messages 

Select if order confirmation windows should be 

displayed.  Select Add Order Confirmation, Delete 

Order Confirmation, and/or Change Order 
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Confirmation if a confirmation window should be 

displayed before adding, deleting, and/or changing 

an order.  Select Cancel Button Default if the 

Cancel button should default on the confirmation 

window.  Not selecting it means the Confirm button 

will default.      

 Order Pane: Select either: No Delay, ½ Sec. Delay, 1 Sec. 

Delay, Center Click Active, or Hide Order Pane.  

See item #80 of the Order Pane section. 

 Order Handling 

Mode 

Select either: LTP Mode or Inside Market Mode.  

This mode is used to determine whether the Last 

Traded Price or Last Traded Bid/Ask is used for 

trailing stops and to trigger a Virtual Stop 

  

20. Within the Help menu there are two menu items: 

 Contents: Displays the PS Trader Read Me Document 

 About PS Trader: PS Trader version information  
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PS Trader – Setup Window 

 
 

Figure 2.  PS Trader Setup Window 

 

21. PS Trader contains a default Setup window, accessible from the Preferences 

menu, which can be used to specify default values for new contracts added to 

the workspace.  In addition, there is a Setup window associated with each 

contract.  Properties specified for one contract can be different than those of 

another contract.   

22. The Setup window for an individual contract can be launched by either 

clicking the Setup button on PS Trader’s Main window, or by right-clicking in 

the price column on the contract’s depth window and choosing Setup. 
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23. The Maximum Quantity field must be a numeric value from 0 to 999,999,999.  

This value must be greater than 0 for orders to be entered in the Depth 

window. 

24. The Default Quantity is the order quantity that will be entered on launch and 

after every order is submitted.  This value must be less than or equal to the 

Maximum Quantity. 

25. The Right-Click Quantity is the order quantity that will be entered when the 

user right-clicks on a contract.  This value can only be set and active if the 

corresponding checkbox is selected. 

26. Clicking on the Apply button saves the properties and leaves the Setup window 

open.  Clicking the Ok button saves the properties and then closes the Setup 

window.  Clicking the Cancel button closes the Setup window without saving 

any changes. 

PS Trader – Depth Window  

 

   
Figure 3.  PS Trader – Depth window 

27. The Depth window will open with the Contract Name as the name of the 

window.   

Virtual Sell Stop 

Working Buy & Sell 

Order 

Right-Click 

Quantity 

Quantity 

Customer Profile 

Working Buy Order 

Net Position  

Last Traded Price 

Working Sell Order 
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28. The Depth window default display separates the Working Buy and Working 

Sell orders.  The user can choose a different display format by right-clicking 

on the depth window and selecting one of the following options: “Right Justify 

Price”, “Split Buy / Sell Orders” and “Hide Status Bar”. 

29. Re-centering the grid can be performed by clicking the middle mouse button, 

double-clicking the price column, or by pressing the space bar.  Clicking the 

down or the up arrow buttons will scroll the window by one whole pane.  After 

re-centering, a dark black line separates the top half from the bottom of the 

grid. 

30. The font size for the Depth window can be increased or decreased by pressing 

the “Shift + Left Arrow” or “Shift + Right Arrow” key combination, 

respectively.  Then the font size of the Order Pane window and the Quantity 

Pad will also re-size accordingly. 

31. The yellow bar in the price column denotes the High of the day.  The red bar in 

the price column denotes the Low of the day.  All prices in-between these two 

bars are a darker gray showing that this is where trading has occurred.  Outside 

of these two bars prices are lighter gray.  

32. The Last Traded Price will be displayed in the Price column by highlighting 

the cell.  The background will be green if the price went up.  It will be red if 

the price went down, and white if it remained the same. 

33. <Default> is the default customer profile name.  Clicking on the field will 

display a list from which a single customer profile can be chosen.  Once 

selected, all orders will be submitted using this customer profile.   

34. Each column can be made wider by grabbing the vertical bar on the right side 

of the header row of each column and dragging it to the appropriate width.  To 

minimize a column, simply slide the handle all the way to the left.  To 

redisplay hidden columns, right-click on the depth window and choose the 

appropriate display. 

35. Dragging the height of the depth window automatically re-centers the grid and 

will dynamically add or remove rows.  The maximum number of rows is 

limited by the size of the screen.  There is no minimum number of rows.   

36. The top left cell of the Depth window is the Default Quantity.  After each order 

this value will be replaced with the default quantity selected from the Setup 

window.  When the Depth window is active, typing a number anywhere will 
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add to the value.  Right-clicking on this quantity field will reset the value with 

the default value.  

37. Directly beneath the Default Quantity is the Right-Click Quantity.  This value 

can be edited directly on the Depth window or by opening the Setup window.   

Quantity Pad 

  

Figure 4.  PS Trader Quantity Pad 

 

38. If Detached Quantity Pad is not selected from the Preference menu, when the 

user clicks on the quantity cell, the quantity pad displays as in Figure 4 and 5.  

There are two tabs within the quantity pad: Quantity Pad and Order Mode.  

The last used tab is remembered and displayed when the quantity pad is 

accessed.  Moving off the quantity pad or clicking the “Close” button will 

close the quantity pad.  See #63 for the detached version of the Quantity Pad.   

39. The value that is displayed in the upper left hand of the quantity pad will be the 

quantity of the order that will be submitted next unless it is changed.   

40. Right-clicking on the quantity, will re-seed it with the default quantity.  

Clicking the “Set as Default” button will save the current value as the new 

default quantity. 

41. Clicking on the Clear button will reset the quantity to 0. 

42. The numbers on the Quantity pad can be overwritten by right-clicking on a 

number, entering the desired number and hitting Enter.  If a number was in the 
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thousands, it will put a decimal between the thousand values and the non-

thousand values and add a “K”.  Ex. 2,500 = 2.5K.   The same applies to 

millions except with an “M”.   

43. The value of the quantity cannot exceed the maximum value specified in the 

Setup window for each contract.  If a number does exceed this value it will 

stop at that maximum number.  (Ex. Max Quantity = 25 and user adds 20 and 

then adds 30, then it will display 25). 

44. Add – Selecting this option will add the quantity to the button that has been 

clicked.  It will add the values “1” & “2” & “10” = 13. 

45. Calc – Selecting this option treats the quantity pad like a calculator within 

Microsoft Windows.  It will concatenate the string “1” & “2” & “10” = 1210. 

46. Replace – Selecting this option replaces the existing quantity with the newly 

selected button.  The result of pressing “1” & “2” & “10” = 10. 

47. Clicking on the Order Mode tab will display the quantity pad in Order Mode.  

By default the Limit button is selected.  

 

Figure 5.  PS Trader Quantity Pad - Order Mode 

 

48. Limit – Clicking on the Limit button allows the trader to submit a Limit order.  

The Time in Force and Order Type fields are enabled. 

49.  The Time in Force field will allow the trader to designate for how long the 

order is valid.  The default selection is GTD: the order is valid only for the 
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current trading session.  Selecting GTC indicates that the order is valid until 

the trader cancels the order or the contract expires.  

50. The Order Type field will allow the trader to designate if the order should be of 

type “Fill or Kill” (FOK), “Immediate or Cancel” (IOC), or “Market Limit 

Market” (MLM).  By default the Order Type will be <None> indicating it is 

not a “Fill or Kill”, “Immediate or Cancel”, nor “Market Limit Market” order. 

IMPORTANT: MLM orders are only available on the SFE gateways and will 

not show up for any other. 

51. Market – Clicking on the Market button allows the trader to submit a Market 

order.  After clicking, the Time in Force and Order Type fields are enabled and 

the cursor changes to a yellow arrow with the letters MRT.   

52. Clicking anywhere in the Bid column will place a Buy Market Order.  Clicking 

anywhere in the Offer column will place a Sell Market Order. 

53. Stop – Clicking on the Stop button allows the trader to submit a Stop order.  

The Stop Limit, Trailing Stop, Virtual Stop, and Time in Force fields are 

enabled.  The cursor changes to a yellow arrow with the letters STP. 

54. The Stop Limit field determines if the order should be a Stop Limit or Stop 

Market order.  Checking the Stop Limit checkbox means that a Stop Limit is 

placed while leaving it unchecked means a Stop Market order will be placed.  

By default the checkbox will not be checked indicating that a Stop Market 

order will be placed. 

55. If the Stop Limit checkbox is checked, the Stop Limit Offset field becomes 

enabled.  The Stop Limit Offset field allows the trader to set the number of 

ticks the stop limit price is from the stop entry price.   

56. The Trailing Stop field allows the trader to designate that the stop order should 

trail with the market.  If LTP Mode is selected as the Order Handling Mode 

from the Preferences menu, the Trailing Offset equals the distance the stop was 

entered away from the last traded price and the stop will trail the LTP.  If 

Inside Market Mode is selected as the Order Handling Mode, for a Buy Stop 

the Trailing Offset equals the distance the stop was entered from the Best Offer 

and the Buy Stop will trail the Best Offer.  For a Sell Stop the Trailing Offset 

equals the distance the stop was entered from the Best Bid and the Sell Stop 

will trail the Best Bid.    
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57. The Virtual Stop field allows the trader to place a virtual stop, which is saved 

on the client machine until triggered, instead of a Stop order which is 

submitted to the exchange. 

58.  If LTP Mode is selected as the Order Handling Mode (from the Preference 

Menu), once the Last Traded Price equals the Stop Price the virtual order will 

be submitted into the market as either a Market or Limit order. 

59. If Inside Market Mode is selected as the Order Handling Mode, for a Buy Stop 

once the Best Offer Price is greater than or equal to the Stop Price the order 

will be submitted.  For a Sell Stop once the Best Bid Price is less than or equal 

to the Stop Price the order will be submitted.  If Stop Limit is not checked, a 

Market order will be placed.  If Stop Limit is checked, a Limit order will be 

placed based on the specified Stop Limit Offset. 

60. If the contract being traded is on the SFE gateway, users will be allowed to 

select “Market Limit Market” (MLM) orders in the Order Type field. 

61. OCO – Clicking on the OCO button allows the trader to submit a One-

Cancels-Other (a.k.a. Order-Cancels-Order) order so that if one gets filled, the 

other will be canceled.  The Stop Limit, Trailing Stop, Virtual Stop, and Time 

in Force fields are enabled.  The cursor changes to a yellow arrow with the 

letters OCO. 

62. An OCO can be either two stops, two limits, or the traditional stop and limit.  

If the OCO contains stops, one or both of those stops can be set as virtual stops 

by checking the Virtual Stop checkbox.  As in Stop Mode, the Stop Limit field 

is used to designate if the order should be an OCO Stop Limit or OCO Stop 

Market order.   

63. If Detached Quantity Pad is selected from the Preferences menu a single panel 

of buttons displays.  The default version hides the fields for selecting the mode 

of the Quantity Pad amounts (Add, Calc, or Replace) as well as the additional 

fields for entering orders other then Limit orders.  The ellipses button can be 

clicked to view those additional fields.    
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Figure 6.  PS Trader Quantity Pad – Detached  Figure 7.  PS Trader Quantity Pad – Detached (expanded) 

 

64. The font size of the detached Quantity Pad can be increased or decreased 

independently of the Depth window.  To do so, select the Quantity Pad and 

press the “Shift + Left Arrow” of “Shift + Right Arrow” key combination, 

respectively. 

Net Positions 

65. The Net Position will be displayed on both the Buy side and the Sell side in the 

last row. 

66. Clicking on one of these values will seed the Quantity field with the absolute 

value of this value.  If this value is greater than the Maximum quantity, it will 

seed the quantity with the Maximum quantity.  

 

Entering Orders 

67. When the user clicks on the blue column in the Depth window they will be 

sending in a Buy order.  When the user clicks on the red column in the Depth 

window they will be sending in a Sell order. 
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68. By default (if the Order Mode has not been changed using the quantity pad) 

orders submitted through the Depth window will be GTD Limit orders at the 

Limit price corresponding with the price of the row that was selected. 

69. For stop orders, the Stop Price submitted corresponds to the price of the row 

that was selected and the Stop Limit Price is based on the stop price and the 

stop limit offset. 

70. The cursor will change to yellow along with the letters MRT, STP, or OCO if 

the user has designated that a Market, Stop, or OCO order should be placed.  

While entering an OCO order after selecting the first price, the cursor will 

change to pink.  After the second price is selected, the cursor will change back 

to yellow.   

71. For OCO orders, when a partial fill comes in on either of the two orders, the 

other order will be reduced by the amount that was partially filled.  When one 

order is deleted, the paired order is also deleted. 

Working Orders 

72. By default both working Buy and Sell orders are displayed on the left hand 

side of the Depth window.  If both a Buy order and a Sell order are resting at 

the same price, the working orders column will display an “x” between the buy 

quantity and the sell quantity (i.e., 25 x 25). 

73. When the “Split Buy/Sell Order” is selected, working Buy orders display in the 

left column while working Sell orders display in the right column. 

74. Right clicking on any order and dragging it to another price level will adjust 

that order, changing its Limit Price.  

75. Left clicking on the order will delete the order.  

76. Left clicking in the total orders field will delete all orders for that contract 

using Smart Delete functionality.  The sequence in which the orders are deleted 

is based on their position in the market.  Orders closer to the market price will 

be deleted before those which are farther away.  This minimizes the chance of 

getting filled in a fast market before all of the deletes can be processed.  

77. Hovering over one order of an OCO order will highlight it yellow along with 

its corresponding order.  If the corresponding order is not currently viewable in 

the Depth window, the order will instead be highlighted in orange. 

78. Virtual Stops have a beige background.  
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Order Pane 

 

Figure 8.  PS Trader Order Pane 

79. The Order Pane, when displayed, shows details about the orders that are 

working.  Figure 8 displays an example Order Pane which contains all orders 

for a given contract. 

80. From the Preferences menu the user can choose from five different settings to 

display or hide the Order Pane: No Delay, ½ Sec. Delay, 1 Sec. Delay, Center 

Click Active, and Hide Order Pane. The “No Delay” option displays the order 

pane immediately after hovering over any working order(s) in the Depth 

Window. The “½ Sec. Delay” and “1 Sec. Delay” options display the order 

pane after a short delay.  The “Center Click Active” option will display the 

order pane when the center mouse button is clicked on a working order in the 

Depth Window, clicking anywhere else will re-center the grid. The order pane 

will stay hidden when the “Hide Order Pane” option is selected. 

81. To change the order Quantity, Price(s), and/or Trailing Offset left click or right 

click the column to decrease or increase the value, respectively.  To commit 

the change(s) click on the “OK” value in the Chg column. A light gray 

background on an item indicates that this value can be changed.  If you change 

a value and leave the window without confirming “OK”, the changes will be 

lost.   

82. To delete an order, click the “X” value in the Del column. 

83. The Stop Price, and Trailing Offset columns will only display if they are 

applicable to the working orders.   

84. Orders are highlighted in yellow to indicate that they are part of an OCO order. 

85. Orders with a Time Stamp of “Not In Market” are Virtual orders, saved on the 

client machine. 
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Order Confirmation window 

86. If the Add Order Confirmation preference is checked on the Global Settings 

menu, a message window will display before any order is placed.  See Figure 

9 below for an example of the Order Confirmation window for a Stop Limit 

Order with a Threshold. 

87. If the user changes the Order Quantity to a value which exceeds the Max 

Quantity, upon leaving the cell the Max Quantity is entered. 

 

 

Figure 9.  Order Confirmation window 

88. Some values for the order can be changed on the Order Confirmation window.  

The Customer can be changed by selecting a different Customer in the 

dropdown.  A different Account Number, Quantity, Stop Limit Offset, or 

Threshold can be entered by selecting the cell with the previous value and 

typing a new one.  A Buy order can be changed to a Sell order or a Sell order 

can be changed to a Buy order by selecting the Buy or Sell value.  The Price 

can be changed by selecting the previous price and left-clicking to reduce the 

price or right-clicking to increase the price.  Trailing can be turned on and off 

for a Stop order by selecting the Trailing Active checkbox.  The Exchange, 

Contract, and Order Type values cannot be changed.  Only the fields 

applicable for the placed order will display in the Confirmation window.  For 

example, the Stop Limit Offset, Trailing Active, and Threshold values would 

not display when placing a standard Limit order. 

89. Selecting the Confirm button will place the order while selecting the Cancel 

button will not submit the order. 
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90. If the Delete Order Confirmation preference is selected, a basic message 

window will display confirming if you want to Delete your order.   

91. If the Change Order Confirmation preference is selected, a basic message 

window will display confirming if you want to Change your order. 

Locally Held Orders 

92. If PS Trader is closed while Virtual Stops are working, a message will display.  

If the user confirms that PS Trader should close, the Virtual Stops will be 

saved.  Upon re-launching PS Trader, the Stops will be in a locally held state 

and can then either be released as virtual orders or deleted.  Locally held orders 

are distinguished by a peach background.  Figure 10 displays the Order Pane 

with a locally held order. 

 

Figure 10.  Order Pane – Locally Held Order 

 

93. In order to release a locally held order back into a Virtual order, click on Send 

in the Rel column of the Order Pane.  The order will change from a peach 

background to a beige background and the Time Stamp column will display 

Not In Market to indicate the order is again a Virtual Order.    

94. In order to instead delete the locally held Order, click the X in the Del column 

of the Order Pane.   

 

Requirements 

This application requires: 

 X_TRADER® API  

 X_TRADER®  


